AJ Because it matters.®

VIDEO SYSTEMS

AJA KONA, lo and T-TAP™ Software Installer

Release Notes - macOS v14.2

Requirements and Recommendations

Operating System
* This software / driver version is compatible with macOS 10.13.x (High Sierra), 10.12.x (Sierra),
10.11.x (El Capitan), 10.10 (Yosemite), and 10.9.5 (Mavericks).

* However, for demanding workflows using 4K/UltraHD and/or higher frames rates such as 60p,
AJA recommends macOS 10.13.x (High Sierra) or 10.12.x (Sierra).

* For additional hardware recommendations and requirements*, please see:
https://www.aja.com/support/kona-system-configuration

Additionally, the AJA Thunderbolt Solutions page contains details to help get you up and
running as quickly as possible, including cable specifications:

https://www.aja.com/solutions/thunderbolt

*Check the Known Issues and Limitations section near the end of this document. See section “Important MacOS
High Sierra Installation Information” relating to security issues for hardware recognition on first install under macOS
High Sierra and later.

Software

The following software versions are compatible with this installer. Note that AJA
recommends using the latest released versions for best performance:

Adobe Apple
- Premiere Pro CC 2018, 2017, 2015 - FCPX-104.1,104,1032,10.3.1,103,10.2.3
- After Effects CC 2018, 2017, 2015 Avid
» Photoshop CC 2018, 2017, 2015 - Media Composer - 2018x,8.10,8.9, 88,87, 86,
- Prelude CC 2018,2017,2015 85,84
- Audition CC 2018, 2017, 2015 Telestream

« Wirecast 8.x, 7.x, 6.X
Other Compatible Applications**
. List of AJA Compatible Software

**Please contact the appropriate software vendor for information on AJA driver versions
required for use in their application.
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New Featuresinvi14.2

* Introduction of AJA KONA HDMI support (new AJA PCle card).

* Introduction of AJA KONA 1 support (new AJA PCle card).

* Introduction of AJA lo IP support (new AJA Thunderbolt 3 device).

* Introduction of Avid DNxIP support (new Avid Thunderbolt 3 device).

* "Deep Buffer”setting in AJA Control Panel, improves handling of storage interruptions during
ingest with AJA Control Room.
- User can now allocate RAM for caching to protect media being written during ingest:
AJA Control Room: Preferences > Capture > “Reserve buffer size for deep capture queues”.

* Expanded analog audio configuration options for lo 4K Plus, Avid DNXxIV, lo IP, Avid DNxIP.
With AJA Control Panel, user can now select from four modes:
- "8in" eight-channel input across A1-8
- "8 out”: eight-channel output across A1-8
+ "4in, 4 out”: four-channel input across A1-4, four-channel output across A5-8
- "4 out, 4 in": four-channel output across A1-4, four-channel input across A5-8

* "Disable creation of SCC/MCC files from Closed Caption data”option in Adobe Premiere Pro CC
2017 onwards, provides user with ability to prevent automatic generation of SCC/MCC Closed
Caption files when capturing a signal with the data present:

Adobe Premiere Premiere Pro CC > Window > Capture > Settings > Edit > Settings > "Disable
creation of SCC/MCC files from Closed Caption data”

- Note that this option is not engaged by default. This is so older projects will remain
unaffected.

- Note that enabling this feature does not prevent the recorded media from encoding the
Closed Caption data. If the data is present in the source signal, then it will be retained in the
captured media.

Fixes, Changes and Improvements in v14.2

Note
[tems below are grouped by the main AJA products affected. Issues may have also

affected other AJA products that are not specifically called out. As such, it may be
worth reading all groupings if you are looking for a specific fix.
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All KONA cards, lo devices and T-TAP

AJA Desktop Software firmware and software versions are tightly integrated. If back-revving to an
earlier version for example, then you may be prompted to update your firmware to match; i.e.
update to an earlier version of the firmware than you currently have installed. AJA Control Panel

firmware update notification language has now changed to reflect this more accurately.

Important updates have been added to the Known Issues and Limitations section near the end
of this document. See items relating to hardware recognition on first install under macOS High
Sierra and later.

Amended display problem with Adobe Premiere Pro CC where during capture of ProRes 422,
ProRes HQ or DNxHR HQX, the canvas appears to show dropped frames (even though the
captured file contains all frames).

Fixed capture problem with Adobe Premiere Pro CC where setting up for ProRes 4444 captures,
resulted instead in uncompressed BGRA clip being written disk.

Fixed capture problem with Adobe Premiere Pro CC where when selecting RGBA for capture,
instead resulted in a black clip being written to disk.

Solved issue with Adobe Premiere Pro CC where auto-creating a sequence from an AJA clip (in a
new project for the first time) could either take over 30 seconds, or else crash the application.
Resolved bad SD video playback in Adobe Premiere Pro CC canvas and loss of AJA Video output,
when choosing to display both fields.

AJA Control Room now provides a confirmation dialog if the application is quit or exited during
capture.

Amended incorrect interface reporting in AJA Control Panel whereby it appeared that input
pass-through is checked, when actually in playback, and vice versa.

AJA Control Panel Frame Buffer and Output are now correctly set to 525i 29.97 when presented
with P2/MXF 480i 29.97 material that is flagged as 23.98.

When Open GL acceleration is not being utilized, SD material no longer shows black at the
bottom of the frame in AJA Control Room viewer during playback.

T-TAP

Fixed issue whereby T-TAP output image would shift horizontally.

Amended behavior in Adobe Premiere Pro CC capture tool, such that it is no longer possible to
attempt to capture from T-TAP (being a monitoring-only device).

Fixed issue whereby upon quitting / exiting Telestream Wirecast, T-TAP was left in a non-
standard configuration. AJA Control Panel reported “In use by OEM application”.

Solved problem in AJA Control Panel, where clicking on the Timecode tab could cause the
application to crash.

lo 4K Plus, Avid DNxIV

Corrected various HDMI display and capture problems caused when AJA device is connected to
an already powered-up HDMI monitor, and then powered on .
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* Solved intermittent issue where switching modes or moving the playhead could then cause
loss of (incoming) EE audio monitoring when using audio punch-in within Avid Media
Composer. Only monitoring was affected, as the audio captured did contain the voice over
content recorded.

* Fixed problem whereby unplugging Thunderbolt 3 cable when AJA Control Panel is set to 4K
Quad Input (Square Division), could in some instances create a kernel panic.

* Amended AJA Control Panel feedback where SDI 5 was being erroneously labelled as Video and
Key, when SDI 3 and 4 were set to Video and Key.

* (Corrected banding on HDMI output when AJA Control Panel Frame buffer is set to YCbCr and
HDMI color space is set to 10bit YUV.

* Rectified problem whereby HDR would turn on, but not turn off completely.
* Remedied audible "tapping” effect during manipulation of volume knob.

lo 4K

* Solved problem with AJA Control Panel where when set to Quad (Square Division) SDI input,
the HDMI output suffered from a green tint, and the HDMI widget reports incorrectly that it is
passing 4K/UHD instead of a down convert to 2K/HD.

* Corrected problem whereby Adobe Premiere playback of 2K formats would set the AJA Control
Panel frame buffer to UHD.

lo 4K, lo XT

* Fixed display of garbage video instead of color bars upon launching AJA Control Panel.

lo 4K Plus, Avid DNxIV, lo 4K, KONA 4

* Solved loss of HDMI output when using an RGB-10 (or ARGB-8 / RGB-12) framebuffer setting
and attempting to set color space to either 10-bit YCbCr / 4:2:0.

* Rectified AJA Control Room problem causing the wrong color space and image aberrations to
display when using SDI RGB input.

lo 4K, lo XT, KONA LHi

* Fixed wrong output from AJA Control Panel. Upon selecting 2K, HD was instead output, and
when selecting 4K, UHD was instead output.

lo Express, KONA LHi

* Solved problem where buffer format selections in AJA Control Panel intermittently provided
incorrect output raster and corrupted imagery.
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KONA 4

* Fixed audio quality problem when using Wirecast while running the UFC firmware available for
KONA 4.

KONA IP

* Fixed issue when using SMPTE 2022-6/7 firmware, whereby a receiving KONA IP would not
reestablish video streams following a manual disable and then re-enable of Video Output (in
AJA Control Panel) on the transmitting KONA [P

* Solved transmit (playback) and receive (ingest) problems with 2K formats (up to p30 max) when
using SMPTE 2022 firmware and JPEG 2000 firmware.

* Solved problem in AJA Control Panel where switching from 2K to SD formats could interrupt
transmit (playback) when using SMPTE 2022-6/7 firmware.

KONA LHi

* Fixed intermittent black frames showing across HDMI and SDI output with Downstream Keyer
when using FrameBuffer over Video In, with either HDMI or SDI In selected as the source (and
setting Match Frame Buffer format to Source).

* Solved locking to input problem with Downstream Keyer when using FrameBuffer over Video In,
with HDMI In selected as the source.

KONA LHe Plus
*  Fixed missing video output when using Wirecast with KONA [LHe Plus.

Features, Fixes, Changes and Improvements in Prior Releases

v14.0.2

* Added improved fan speed regulation for lo 4K Plus and Avid DNxIV
* Removed gain-knob “zipper”sound on Mic Input for Avid DNxIV

v14.0.1

* Added option for HDMI Audio Ch 3/4 Swap for lo 4K Plus and Avid DNxIV

* Added option for SDI Input / Output Quad Swap for lo 4K Plus, 1o 4K, KONA 4 and Avid DNxIV
* Fixed general HDMI output timing and stability (of particular benefit for HDMI 1.4 monitors)
* Fixed HDMI output issues with Kona 4 on macOS

* Fixed UltraHD HDMI output in 2SI

* Fixed intermittent input detection when HDMI is input source

* Fixed lack of Quarter Res output on SDI 3

5| AJA Software Installer - macOS v14.2 WWW.aja.com


http://www.aja.com

* Fixed Closed Captioning for SD output

* Fixed input pass-through widget in Control Panel to show correct activity (HDMI down convert)

* Fixed issue whereby Control Panel reports device as both lo 4K Plus and DNxIV

* Fixed Virus Check issue with AJA Multi Channel Config

* Reinstated Python models within macOS and Windows installers

* Fixed issue whereby Control Room would display an AV sync issue during capture (but capture
OK)

* Fixed issue whereby Adobe Premiere Pro would display an AV sync issue during capture and
resultant capture was out of sync

* Fixed intermittent snapback at start of playback with Avid Media Composer

* Fixed Toggle P/PSF reactivity with Avid Media Composer (now instant)

v14.0

* Added Audio Mixer to AJA Control Panel

* Fixed issue whereby wake from sleep required FCPX restart

* Fixed reliability of Timecode out with FCPX

* Fixed issue whereby an application restart was required to recognize changes in HDR settings
changed in AJA Control Panel when running FCPX

* Fixed Kernel Panic after Sleep > Wake > Launch FCPX cycle

* Fixed issue whereby “loclasscount for AudioStream”did not reset to zero upon Thunderbolt plug
cycle with Apple FCPX

* Fixed reverse playback of interlaced material (where fields were incorrectly swapped) within
Adobe Premiere Pro CC

* Fixed issue with cueing clips from the bin following an icon scrub, whereby a frozen frame
manifested on playback on 1st attempt within Adobe Premiere Pro CC

* Fixed jump in playback when video delay is set past zero within Adobe Premiere Pro CC

* Fixed RP188 output from source viewer in Adobe Premiere Pro CC

* Fixed playback issue for 2Kp60 projects in Avid Media Composer

* Fixed severe frame dropping & A/V sync loss when playing AMA linked P2 AVC-I within Avid
Media Composer

* Fixed issue whereby T-TAP leaves device in OEM mode on Wirecast exit

* Fixed issue whereby Control Panel crashes if launched with no device connected

* Fixed inoperable contextual menus on Mac within Control Panel

* Added VTR on/offline icon to Batch Capture bin window in Control Room

* Fixed issue whereby device offline dialog gets stuck in loop for batch captures when clicking
"OK" in Control Room

* Fixed issues whereby Timecode for current position stops updating, when video option set to
“no video” within Control Room.

* Fixed bad timecode with playback of DPX Cineon header sequences in Control Room

* Fixed 1 second lag for actual capture to begin, with DVCProHD 'on the fly' captures in Control
Room

* Now possible to choose category dividers in compressor dropdown menu as compressors
within Control Room

* Fixed failure to connect to AJA device after 2nd sleep with downstream Thunderbolt device
attached
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* Fixed issue whereby AJA thunderbolt device fails to be seen after sleep/wake cycle
* Fixed issue whereby ProRes 4k 4444 clips w/ alpha don't setup AJA device correctly
* Renamed the main AJA Desktop uninstaller in Program and Features
* Fixed intermittent 720p varicam playback issues with T-TAP
* When using Square Division with KONA 4, 1o 4K, lo 4K Plus and Avid DNxIV, Quad link SDI
sources are no longer viewable in UltraHD via HDM|, instead these sources will be down-
converted for HD monitoring via HDM|
NOTE: This limitation does not apply to 2SI sources.
When using 2SI, Quad link SDI sources can be monitored in UltraHD via HDMI.
* |tis no longer possible to decimate HFR material in order to facilitate HDMI playback on a
monitor not capable of HFR when using KONA 4, lo 4K, lo 4K Plus.

v13.0

* Fixed video freeze occurring during loop playback in Adobe Premiere Pro CC

* Fixed bad video resulting from RGBA 8 bit capture in Adobe Premiere Pro CC

* Enabled AJA plug in for Adobe After Effects to be installed, without Premiere Pro CC

* Fixed memory leak when Capture windows left open in Adobe Premiere Pro CC

* Fixed issue whereby MXF files captured in Control Room, could not be linked to with Avid
Media Composer (File>Import>Link to media)

* Fixed a duplicate clip issue in AJA Control Room (when attempting to overwrite with new file)

* Fixed AJA Control Room GUI issues (Capture / Playback interface problematic with no input
connected)

* Fixed AJA Control Room issue with missing edit In Point (shuttling engaged via frame stepping
following “go to IN")

* Apple ProRes now recognized on imported clips in AJA Control Room

* Improved Thunderbolt™ plug and play performance

* Fixed Timecode reporting for DF RP188 captures (DF was reported as NDF)

* Fixed Horizontal line in SDI 4 of lo 4k and KONA 4

* Fixed UHD test patterns

* Fixed ETT issues (where having a DVCproHD clip loaded caused video input distortion)

* Improved compatibility with AMD graphics cards

* Fixed DVCProHD Routing issue (stuck in DVCproHD playback)

* Fixed issue with HDMI input producing bad video with AJA lo 4K

* Fixed issue where selecting analog input as reference, causes HDMI input to instead become
reference source on AJA KONA LHi

* Improved Level B handling (on input to AJA device)

* Fixed conflict between AJA desktop software and Blackmagic Design software occurring when
uninstalling AJA desktop software

v12.5.1

* Fixed Genlock selection for Analog Input Video Source on KONA LHi

* Fixed issue where12-bit HDR Color Space setting was missing on Adobe Premiere 2017

* Fixed issue where QuickTime files captured with 32-bit integer audio wouldn't play audio in
some 3rd party apps

* Removed 32-bit audio option from MXF to prevent incompatibility in Adobe Premiere
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* Fixed VPID issues for Dual-Link connections on all KONA and lo devices

* Fixed issue whereby quick use of JKL keyboard keys on Avid Media Composer could put audio
into a loop

* Fixed issue in AJA's Control Panel whereby AJA's Control Panel would crash following a click of
the line in test pattern drop drown

* Fixed 2K 23.98 playback issues on T-TAP

v12.5.0

* Improved DNxHR performance on capture

* Improved Thunderbolt hotplug cycles behavior

* Fixed issue where RP188 VITC shown when only RP188 LTC is present

* Fixed issue when ANC TC on SDI 2 was not previously shown in AJA's Control Panel

* Fixed issue where State of Genlock was not saved or recalled correctly in AJA's Control Panel
Presets with lo XT

* Fixed issue where Ref/LTC would switch to Ref when selecting the Playback pane in AJA Control
Room with lo XT

* Fixed Capture Now offset issues between video and timecode with 9 pin set as timecode source

* Fixed issue with audio system crashes when switching from one application to another or from
one plugin instance to another on macOS

* Fixed issue with applications hanging when lo4K is hot unplugged

* Fixed many improper VPID issues

* Fixed issue with 4K/UHD 2SI input not being captured properly on KONA 4 and lo 4K

* Fixed issue where Control Room captured clips are always non-drop TC

* Fixed issue with bad output after wake from sleep on macOS

* Changed all'425'strings in AJA Control Panel to read ‘2-SI'to denote 2 Sample Interleave
method of transmitting 4K and UHD

* Fixed issue with AJA output not working in Premiere Pro after changes in Adobe Playback
Preferences

* Fixed issue with capture in Premiere Pro where selection of Stereo Audio would create files with
discrete mono tracks

* Fixed issue where closing some applications caused HDMI audio output to always reset to 8
channels

* Fixed issue where old video frame flashed on AJA output when switching from timeline to
timeline, or from timeline to source monitor in Premiere Pro.

* Fixed issue with audio stutter on Wirecast output

* Fixed issue with background noise created on live stream and recorded file in Wirecast

v12.4.1

* Fixes issue which intermittently caused AJA driver not to read the AJA hardware serial number
correctly.

v12.4.0
* Fixed issue where 8-bit YUV playback was bad in Premiere Pro with when Mercury GPU is off.
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* Fixed issue where switching from AJA device to Adobe Desktop Audio in the Premiere Pro
Playback preferences causes erratic behavior when the AJA device is selected as the System
Audio device in macOS.

* Removed AJAUncompressedCodec.component from the AJA Driver installer on macOS.

* Fixed issue that caused video output to freeze in Premiere Pro when performing a trim function

* Changed the way the audio hardware was being used

* Fixed issue that causes Premiere Pro to freeze and/or crash during capture on macOS 10.11

* Fixed issue where AJA Control Panel does not hold onto a user preference for 1080p high frame
rate 3G Level B. After a reboot, it always reset to Dual Link 1.5G.

* Fixed issue with audio only files in the Premiere Pro source monitor playing back with a stutter
when AJA Transmit plugin is using minimum buffer mode

* Fixed issue where legacy AJA After Effects Preview Plugin (Blithook) would not release the AJA
hardware when trying to switch out of After Effects to another application

* Changed the way Adobe After Effects is supported. Two different plugins were being installed
before. The ‘Blithook’plugin was the old legacy plugin and is no longer installed by default. It
must be deliberately chosen as an option in the installer. The Transmit plugin is installed with
the default installation options. Please see the Adobe Plugins manual for more information.

* Added NCLC color profiles to QuickTime file creation in Control Room

* Added updated DNxHR codec to Control Room and Adobe Capture plugin which improved
DNxHR capture performance.

* Fixed issue where AJA System Test failed when trying to test DMA speed on T-Tap

* Fixed issue where DV and DVCProHD codecs didn't appear in Control Room and in Premiere Pro
capture plugin when AJA hardware was in 25 or 50 fps modes.

* Fixed issue where 1080p50/59.94/60 projects in Media Composer would always switch AJA
hardware into 3G SDI Level A Mode. Dual Link and Level B were not possible. Now, the user can
choose this setting in AJA Control Panel before Launching Media Composer, and the setting will
be honored.

* Fixed issues with controlled capture failing in Control Room

* Changed DNxHD naming conventions in AJA Control Room to match the conventions in the
DNxHR

* Fixed issue where controlled capture in AJA Control Room always created a file with 16 tracks of
audio.

* Fixed issue where 10-bit HDMI Input to lo4K was being handled as 8 Bit.

* Fixed Capture in Premiere Pro using DV compression

* Fixed issue with bad test pattern output from lo 4K after host computer sleeps (firmware
update)

* Fixed issue where capture of several DNxHD clips in AJA Control Room causes Control Room to
crash

* Changed macOS and Windows installers to not install the legacy AJA After Effects Preview
plugin by default. The plugin is still inside the installer, but must be selected by the userin a
custom install. This older plugin should only be used in situations where performance of
Transmit is not fast enough.

* Fixed issue in KONA 3G where RP-188 Timecode could not be read correctly from SDI Input 2
(firmware update)
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* Fixed issue where controlled capture in Control Room appears that the out value changes after
the capture begins. The out point is correctly executed, but the value appears cosmetically
incorrect.

* Fixed issue where frames might be skipped at start of timeline playback from Media Composer

* Fixed issue where first frame of playback after scrub might be incorrect frame in Media
Composer

* Fixed issue where looped playback in Media Composer could cause an exception error

* Fixed issue where Video and Audio millisecond offsets in Premiere Pro Playback could cause
video to skip a few frames at the beginning of timeline playback

* Fixed cosmetic issue in AJA Control Room where VTR out point appeared to change after a
controlled capture began

* Fixed issue in KONA LHe+ where AES XLR could not be selected as the Audio Input source in
the AJA Control Panel. Requires firmware update.

* Fixed issue on lo 4K where analog audio settings were not reflected correctly in AJA Control
Panel

* Fixed Frame accuracy during capture of 720p formats in Adobe Premiere Pro

* Improved device control in Adobe Premiere Pro with fractional frame offsets in the device
control plugin. Fractional frame offsets can be used to tweak capture and layoff offsets by less
than one frame when edits and captures are out intermittently. Please contact AJA support for
more information.

* Fixed capture of R-188 Timecode in Premiere Pro

* Fixed issue with T-Tap and lo Express not holding their correct video format settings in Premiere
Pro

* Fixed issue with RGB HDMI input not working correctly in 1o 4K

* Fixed issue with AJA Control Room not inserting the first frame of audio during an insert edit.

* Fixed issue with AJA Import plugin for Adobe Photoshop where captures would have crushed
levels

* Fixed issue with VPID on 2-Sample Interleave formats being wrong

* Fixed banding in lo 4K and Kona 4 with HDMI output of 4K and UltraHD

* Fixed issue in KONA 4 and lo4K where images get skewed if the downstream keyer is being
used

* Fixed issue where switching video formats can cause the picture to lock up in the wrong place
vertically.

* Fixed Audio and Video offset settings in Premiere Pro Playback Settings
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Relevant Products

The following products are covered by this update:

lo 4K Plus KONA 4

Avid DNxIV KONA HMDI
loIP KONA IP

Avid DNxIP KONA 1

lo 4K KONA 3G

lo XT KONA LHi

lo Express KONA LHe Plus
T-TAP

Known Issues and Limitations

General
* ‘System Sleep’or'Hibernation’should not be used with KONA and lo devices. All sleep and power
efficiency modes should be disabled in the operating system settings.

* KONA LHi has only one audio system and is limited to capturing or outputting one channel at a
time with audio. In applications where multiple video inputs and outputs can be used at the
same time, the SDI input will have audio and the HDMI input will not. Additionally, if both input
and output are used simultaneously and independently (as opposed to output passed through
from input) only one channel will have audio.

e MXF OP-1A capture in both AJA Control Room and Adobe Premiere CC does not support the
following formats :720p60, 1080i30, 1080p30, 1080p60.

Important macOS High Sierra Installation Information

* With the introduction of macOS High Sierra (v10.13), Apple now requires that third party
application developers be identified during kernel extension installations. Failure to do so will
make AJA devices fail to operate (Unsupported AJA Device).

* Depending on your macOS version and AJA Desktop Software installation history, the following
installation outcomes are possible:

o macOS Sierra and Earlier Supported Versions
No problems exist for AJA software installation or updates with these earlier versions of macOS.
o Earlier macOS to High Sierra Update
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No problems should occur if you already have the AJA Desktop Software package

installed on macOS Sierra (or earlier) and update your Mac to High Sierra. The identification of AJA
as a trusted developer is passed from the earlier macOS to the High Sierra macOS.

o macOS High Sierra First AJA Desktop Software Install

No problems should occur if your Mac is running High Sierra macQOS, you install AJA Desktop
Software for the first time, and you follow the instructions shown during installation (Figure 5).

Figure 5. MacOS High Sierra Blocked Message Prompt

System Extension Blocked

3 I’ A program tried to load new system extension(s)
signed by "AJA Video Systems". If you want to enable
these extensions, open Security & Privacy System
Preferences.

Open Security Preferences -o'_

Do NOT click OK. Instead click Open Security Preferences (or go to System
Preferences>Security and Privacy) and then click Allow for AJA Video Systems
developer (Figure 6).

Figure 6. MacOS High Sierra System Preferences, Allow Developer

® < HH Security & Privacy Q

.W. FileVault  Firewall  Privacy

A login password has been set for this user ~ Change Password...

Require password 5 minutes u after sleep or screen saver begins
Show a message when the screen is locked

v Disable automatic login

Allow apps downloaded from:

System software from developer “AJA Video Systems” was blocked Allow
from loading.

[ ] Click the lock to make changes. ?
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NOTE: If after successful installation, you remove AJA applications from your computer
using the AJA Uninstaller, developer identification is retained by macOS High
Sierra. Re-installation should proceed without any problems.

* Recovery from Installation Approval Failure

o Ifyoujust clicked OK during installation and skipped the developer approval
step, the AJA Desktop Software installation will complete, but essential extension
installations will not occur and AJA devices will not be operational (Unsupported
AJA Device).

o Apple has engineered a time window, within which you can belatedly approve
a developer after a partial installation. If you go to System Preferences>Security
and Privacy, within 30 minutes of a partial installation, the developer message
and Approve button will be available for use. After 30 minutes, however, the
message and button are removed from the window. Recovery from this involves
uninstalling all AJA files (some manually), reinstalling the AJA Desktop Software
package, and clicking on Allow for AJA Video Systems developer.

* Recovery Procedure

1. Run the AJA Uninstaller, located in the AJA Utilities folder in the Mac Applications folder.
2. Access the Users Library, which is hidden. To access the library:

a. Go to the Finder.

b. In the Finder Menu Bar and click on Go.

. Hold down the Option key. The Library folder appears as long as the Option key is held
down.

3. Go to Library>Preferences and delete all com.aja.*.* files. There may be one file or several files.
4. Remove AJA Control Panel from the Dock, if applicable.

5. Restart the Mac.

6. Install the AJA Desktop Software package.

7. During installation click on Open Security Preferences (or go to System Preferences,>Security
and Privacy).

8. Under the General tab click on the Allow button for AJA Video Systems. The button is only
available for 30 minutes.

Wirecast

* When configuring a multi-channel card such as lo 4K or KONA 4, the inputs must be configured
first if you plan to use the live program output feature. This will set the master clock for the card
(either NTSC or PAL), otherwise the card will be set to 1080i-29.97 by default and could cause
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the card to try and mix PAL and NTSC clocks. Be sure to configure all of your inputs and outputs
in AJA Multi-Channel Config prior to launching Wirecast.

Adobe Plug-Ins

* Audio output from AJA devices can be compromised when sequence framerates do not match
hardware framerates.

* This can occur when working in 720p formats other than 720p-50, 59.94, 60.

* To work around this limitation, go to Premiere Pro Playback preferences, and set the AJA video
device to'Match Control Panel’ Then set up a cross-conversion to output 1080 format. For
example, if using a 720p-23.98 project, set the AJA Control Panel to cross-convert to
1080PsF-23.98, which is a valid SDI output.

* Timecode is not stored in crash captured clips when the timecode source is RS-422. If this is
required, use embedded timecode instead of RS-422 timecode.

* Variable frame rates (VFR) with pull down added are not adjusted for timecode.

* ‘Crash Capture’and 'Print to Video' will work on Varicam frame rates over HD-SDI, but ‘Insert Edit,
'In/Out. Capture, and ‘Batch Capture’will not.

* When insert editing on Panasonic decks, destructive edits may occur too early on the tape. In
order to avoid this, be sure that menu item 202 “ID SEL”is set to "“OTHER”.

* Preroll shorter than 4 seconds is not recommended for use with any deck, for capture or
layback.

* Premiere Pro defaults to‘Display First Field"in its monitor wing menus. If interlacing issues
appear on the output of AJA hardware, try changing this setting to ‘Display Both Fields.

* When changing from a DF tape to an NDF tape on the same deck, with the Premiere Pro
capture window open, the NDF/DF status may not be picked up correctly. If this happens, the
timecode values seen in the Premiere Pro capture window may be incorrect.

* This Issue will NOT affect users unless they are changing between DF and NDF tapes on the
same deck, in the same Premiere Pro Capture session.

o To Avoid This: Always give the new tape a new name in the' Tape Name'dialog that appears
when changing tapes and be sure to let the new tape spool up all the way before clicking the
‘OK’button on the dialog.

o To Fix This: Close the Premiere Pro capture window and reopen it.

* When capturing from or exporting to a Panasonic D5 deck, the timecode source setting in the
AJA Premiere Pro Device Control plug-in must be LTC+VITC.

Avid Open 1/0 Plug-ins
* For the AJA device to be selectable for audio-only capture in the Capture Tool, it must first be
selected in the Capture Tool:
o Open the Capture Tool
o Select both the Video Input and Audio Input as AJA KONA or AJA lo
o Initiate your audio only capture
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* For the AJA device to be selectable in the Audio Punch-In Tool, it must first be selected in the
Capture Tool:

o Open the Capture Tool

o Select the Video Input as AJA KONA or AJA lo
o Close the Capture Tool

o Open the Audio Punch-In Tool

o Select the Input Device as AJA KONA or AJA lo

* Indefinite looping of the timeline with Open I/O plug-in installed may cause Avid applications
to stop playback and give an error message.

* When capturing Dual-Link RGB sources using KONA 3 or KONA 3G, the E/E pass through signal
may be incorrect on the Dual SDI output.

* The AJA hardware genlock may switch between‘Input’and ‘Reference’ when ‘Reference’has
been selected in the AJA Control Panel. Specifically, this is known to happen when attempting
to batch capture in Media Composer, causing some clips in the batch to not be captured. To
work around this issue, select‘Input’genlock in the AJA Control Panel when batch capturing.

* Occasionally analog video input will not be detected correctly in the Media Composer Capture
Tool. As a workaround, play the source video when you start up Media Composer.

Technical Support

AJA Technical Support is free and available to help you answer questions or resolve
issues with any of your AJA products.

To contact AJA Technical Support:

Web: www.aja.com/support Shipping:
Email: support@aja.com AJAVideo Systems
Phone: +1-530-271-3190 180 Litton Drive,
Fax: +1-530-274-9442 Grass Valley.

CA 95945

USA
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